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Next Meeting 
 

November 20, 2008 
 

Mystery Noght 
 

Halloween may have been last month, but the November CUE meeting  
is shaping up to be another night of mystery.  

 
As of press time, the agenda for the meeting had yet to be finalized. Ini-
tially it was hoped to have a guest speaker this month. Another idea that 

was tossed around was for another of our Q&A sessions, where you 
bring in your hardware or software questions or problems, and see if the 

‘experts’ in the group can solve them for you. 
 

What will take place? It’s anybody’s guess right now. Why not come 
and join us to see how the Mystery of the Meeting turns out!! 
 
 
 
 
 

 
 
 
 
 

 

7 pm, Holy Rosary School 
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independent, non-profit computer user group, dedicated to the educa-
tion and support of our members. The opinions expressed herein are 
those of the individual authors or the editor, and do not necessarily 
reflect the opinions of CUE.  
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all rights reserved. Permission to reprint is hereby granted to any Non
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stricted by the original author or source. 
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Newsletter Exchange: CUE welcomes newsletters from other user groups. If you 
would like to exchange newsletters, either by US Mail or via electronic (Internet) 
delivery, please send your newsletter to the address listed below. We will add 
your name to our mailing list and send you our newsletter in return. 
 
Address Changes: Any recipient of Horizons is urged to submit a change of ad-
dress notification to the Editor, either via US Mail to the address shown below, or 
(preferably) via email, so we may keep our records accurate. 
 
Submissions: Submissions are always welcome from our members or outside 
sources. Submissions may be articles, images, cartoons, etc. For first-time au-
thors, please request a copy of our Submissions Guidelines from the Editor, 
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Computer Users of Erie 
PO Box 8941 

Erie, PA  16505-0941  USA 
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  For fastest results, direct your email correspondence directly to the desired individual.  (If 
no personal email address is found, direct your message to the CUE email address, and it will 
be forwarded. Please indicate the desired recipient). 
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  The Computer Users of Erie (CUE), a non-profit affiliate of APCUG, is not connected with, nor does it represent the interests of such organizations as IBM, Apple, Texas 
Instruments, Microsoft, or any other manufacturer or vendor, nor can it assume responsibility for the accuracy or misrepresentation of materials or statements found in 
advertisements, articles, announcements, or presentations appearing in its newsletter or at CUE-sponsored meetings. 
 
  The members of the CUE Board of Directors, committees and SIGs are volunteers giving of their time and energy to assist CUE members through education. CUE shall 
not be held liable in name or performance for the outcome of activities or agreements to provide services offered by any person in the name of CUE. 
 
  CUE welcomes comments, letters, original articles and programs for its newsletter "Horizons". Such materials may be submitted to: OnCUE Editor, P.O. Box 8941, Erie, 
PA, 16505-0941. Permission is hereby granted to other non-profit computer user groups to reprint articles appearing herein, unless specifically restricted, provided 
credit is given to both its author, if known, and its original source. 

CUE Disclaimer 
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Meeting Location Finder 
 

DH   Dave Howell • 3904 Myrtle • 866-7308 • dhowell63@neo.rr.com 
HR   Holy Rosary • 1012 E. 28th (park behind school)  • Contact Lou Cioccio • 868-1320 • lcioccio@mac.com 
TK   Tom Kuklinski • 3699 Dogleg Trail •  814-746-9165  •  tkuklinski@gmail.com 
LC   Lou Cioccio • 5753 Glenview Dr. • 868-1320 • lcioccio@mac.com 
BE   Bill Ellis • 1502 Winslow Dr. • 868-2680 • willardellis8@gmail.com 
 

 
All meetings begin at 7 pm, except for Mac SIG, which is 9 AM (UNLESS otherwise noted by SIG leader). 

PLEASE RSVP for all SIG meetings, to allow for planning changes or meeting postponements.  

November 2008 
Sun Mon Tue Wed Thu Fri Sat 
      1 

2 3 4 
 

5 
Digital Photo 
(HR) 

6 7 8 
Mac 
(HR) 

9 10 11 12 13 14 15 

16 17 18 
BUG  
(TK) 

19 20 
General Meeting 
(HR) 

21 
Newsletter 
 Deadline 

22 

23 24 25 26 27 28 29 

30       

December 2008 
Sun Mon Tue Wed Thu Fri Sat 

 1 2 
Genealogy 
(DH) 

3 
Digital Photo 
(HR 

4 5 6 

7 8 9 10 11 12 13 
Mac 
(HR) 

14 15 16 
BUG  
(TK) 

17 18 
General Meeting 
(HR) 

19 
Newsletter 
 Deadline 

20 

21 22 23 24 25 26 27 

28 29 30 31    
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meeting.  The October meeting will 
take place on October 21. 
Digital SIG:  The October meeting 
planned upcoming activities.  The 
group will continue working on PSE 
6 emphasizing Layers.  Lou Cioccio 
requested members bring a “lousy” 
JPEG photo, either under of over 
exposed, for the group to work on. 
Mac SIG:  Lou talked about his lat-
est project, a Hackintosh.  For educa-
tional purposes Lou had begun as-
sembling an Intel based machine to 
have PC parts running a Mac OS.  If 
the project didn’t work out, he would 
give it to his son to use as a PC.  The 
parts were off the shelf, mostly from 
eBay. 
 
Newsletter:  Mark has articles from 
the Genealogy and BUG SIGs and a 
book review for the October issue.  
He still needs more local articles.  
Books are now available from a new 
vendor, Focal Press, at reduced 
prices or for no cost if the member is 
willing to write a book review.  Fo-
cal Press is a well regarded publisher 
in the area of photography and 
graphic arts. 
 
Old Business:  None 
New Business:  None 
 
Guests introduced:  Tom Sapola of 
Erie  and John Kreger of Erie. 
 
50/50 Drawing was for half of an 
$18 pot and was won by Gene 
Meeks. 
 
At 7:34 PM a motion to adjourn was 
made by Debora Cole, seconded by 
Greg Ames. 
Respectfully submitted, 
John Fair 
 
 
 
 

 
 
Meeting Adjourned:  6:57 PM 
 
Respectfully Submitted, 
John Fair 
 
 
 
GENERAL MEETING 
 
October 16, 2008 
Thursday   7:12 PM 
Holy Rosary School 
 
Members in Attendance:  about 10 
plus 2 guests 
 
Olen Seidler:  Opened the meeting at 
7:10 PM 
 
Reports and Readings: 
September minutes were published 
in the newsletter.  No additions or 
corrections.  Motion to accept as 
published made by Lee Williams. 
Sam Fletcher seconded the motion. 
 
Web Site Committee:  Mark Mattson 
described how Tom Kuklinski has 
taken over as webmaster but Mark 
will continue to work with Tom. 
Nomination Committee:  Olen re-
minded the committee members that 
elections would be coming up in a 
few months and they should be con-
sidering who might be on the slate. 
Publicity and Awareness Commit-
tees:  Since both Scarlett Skarupski 
and Tom Kuklinski were absent, 
there was no report. 
 
SIG Reports: 
Genealogy SIG:  Dave Howell was 
absent, so there was no oral report on 
the October meeting.  September’s 
report was published in the newslet-
ter. 
Basic Users Group (BUG) SIG.  
Tom Kuklinski was absent, so there 
was no oral report on the September 

Secretary’s Reports 

  BOARD MEETING 
 
October 16, 2008 
Thursday 
Holy Rosary School 
6:20 pm 
 
Olen Seidler 
Lee Williams 
Lou Cioccio 
John Fair 
Sam Fletcher 
Mark Matson 
 
Olen:  Brought up the need for email 
addresses for 4 members. 
He read Dave Howell’s report on 
Genealogy SIG’s discussion of fund-
ing magazine subscriptions. 
 
Lee: Made the point that all SIG’s 
need to be treated equally if funding 
support is to be given from CUE to 
its SIG’s.  Since no other SIG had 
requested funding, perhaps the Gene-
alogy SIG members should consider 
the cost impact.  If that SIG’s mem-
bers shared the $120, the individual 
cost would be $120/18 members or 
$6.67 per member of the Genealogy 
SIG.  If each SIG is supported 
equally at the same level, the indi-
vidual cost to every CUE member 
would be $120 per SIG x 4 SIGs/40 
members or $12 per member of 
CUE.  So the Genealogy SIG mem-
bers would pay more if the $120 
came from CUE instead of the indi-
vidual SIG members absorbing the 
cost. 
 
John: Suggested the above point be 
made to the Genealogy SIG before 
bringing the subject before the mem-
bership and expressed concern about 
potential copyright infringement if 
emailing copies of articles from 
magazines to SIG members. 
 
Olen will bring the subject up to the 
Genealogy SIG.   
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  How to cheat in PHOTOSHOP 
Elements 6 works with Elements 
versions 3 to 6. It is published by 
Focal Press and is 
written by David 
Asch & Steve Caplin. 
The book includes a 
CD-ROM that is for 
PC and MAC users. 
  
  This book is the 
book you want if you 
would like to see and 
learn step-by-step 
methods on how to do 
the “Magic” so many 
people associate with 
Photoshop, but is 
available with Ele-
ments. 
 
  The book is broken down into 12 
very easy to understand chapters: 
 
Selection techniques pg 4 
Montage essentials layers pg 20 
Hiding and showing pg 38 
Image adjustments pg 56 
Light and shade pg 78 
Transformation & distortion pg 98 
Materials and textures pg 120 
Working with text pg 148 
People and animals pg 168 
Shiny surfaces pg 196 
The third dimension pg 212 
Print and the internet pg 230 
 
 
  The “cheating” of this book is actu-
ally SHORTCUTS  that help you do 
the “exercises” presented in the book 
faster, better, and smarter. 
 
  The book comes with a website and 
a reader forum if you have any ques-
tions or problems with anything pre-
sented in the book. The CD includes 
all the photographic material in the 
book. Plus some QuickTime movies 
showing specific techniques in ac-
tion…so many of us see something 

done better than we understand read-
ing about. We all can’t always visu-
alize everything the way the author 

intended. The CD 
also includes cus-
tom Shapes and 
Layer Styles to 
import in to Ele-
ments to apply to 
your own work. 
 
Now for the 
“cheating”… 
 
  In chapter one 
under Selection 
techniques you 
learn about the 
Magic Selection 
Brush. Personally 
I have heard about 

the Magic Wand. But the Magic Se-
lection Brush and how to use it was 
interesting stuff. 
 
  In chapter three under Hiding and 
showing you learn about creating 
effective photomontages. You also 
learn how to blend and arrange the 
montages so they appear more con-
vincing. 
 
  In chapter four under Image adjust-
ments you learn about the perfect 
respray, changing skies, and going 0-
60 in ten minutes. 
 
  In chapter seven you learn how to 
lie on a bed of satin and the art of 
paper tearing. 
 
  One of my favorites, was under 
working with text. I always wanted 
to know how to do this “trick” and 
had tried to do myself before…
writing in the sand.  
 
  This is the book you want to read 
would like to learn the in’s and out’s 
of Elements and the shortcuts and 
how to use them. 

  Ed. Note: 
 
  As mentioned, this book is available 
from Focal Press, either direct from 
them at their website 
(www.focalpress.com), or from your 
favorite book store. 
 
  List price is $34.95 plus shipping, if 
ordered online. 
 
 
  Focal press is now one of CUE’s 
partners, providing our members 
with a special user group discount. 
 
  To take advantage of this discount, 
order from them direct either online 
or phone, and mention the discount 
code  92995 to receive a 20% dis-
count on your order. 
 
  There IS a banner on our website 
pointing you to Focal Press. HOW-
EVER< the link actually takes you to 
their parent company home page. To 
access the Focal Press site, look for 
the link to it along the left side of the 
page you are taken to. This is NOT a 
mistake with the link associated with 
the banner, but it is the one they re-
quire us to link to. 
 
  Focal Press has been in business 
for 70 years, and publishes many 
photography, video, and graphics 
related titles, among others. Be sure 
to check them out to see what they 
offer. 

Book Review - How to Cheat in Photoshop Elements 6 
 

By Tanya Mattson, Computer Users of Erie 
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  The first order of business was the 
distribution of genealogy articles 
ordered by members of the SIG. 
 
  Dave reported the reaction he got 
from the CUE Board regarding the 
budget request we made that is ear-
marked to defray the costs of provid-
ing genealogy reference materials to 
SIG members. The Board indicated 
that CUE is operating on a "bare 
bones" budget based on an annual 
dues of $20 - down from $25 in past 
years and that if they provide a 
budget for us, they would also have 
to offer same to other SIGs thus re-
sulting in an increase of our annual 
dues. 
 
  The group present tonight decided 
to look at less expensive ways to 
provide those articles. If Dave is suc-
cessful with updating his scanning 
software, he might be able to upload 
the requested articles to the SIG 
membership without cost. The group 
advised Dave how this might be 
done. Dave will try this approach 
using his older SCSI-based scanner 
and Windows 98 FE desktop. 
 
  The CUE Board also asked Dave to 
research the issue of providing 
"copyrighted" articles to members of 
our group. Knowing that getting ad-
vice from an attorney might prove 
expensive, Dave accessed the U.S. 
Copyright website and obtained ma-
terial that dealt with the issue. Since 
CUE is an "unofficial" non-profit 
organization and essentially an edu-
cational one at that, the law permits 
limited distribution of materials to its 
members provided the material is not 
published to the general "public" and 
that the author(s) are identified in the 
article(s). The group decided that 
changing the subscription from 
Dave's name to "Genealogy SIG of 
C.U.E." will further legitimize the 
educational intent of our activities. 

 
  Since all payments for the Ances-
try.com Subscription have been re-
ceived, Dave will send the new pass-
word to all those who have paid. 
 
  The remainder of the evening was 
spent viewing the second Legacy 
tutorial CD brought to the meeting 
by Bill. (The first tutorial for the 
"Beginner" is already available to 
everyone through Millennia's web-
site.)  
  
  The second Legacy tutorial CD dis-
cusses the techniques of entering (1) 
Names, (2) Dates, and (3) Places. 
Legacy 7.0 is so vast and detailed 
that to master everything in the soft-
ware is a daunting task even for ex-
perienced genealogists. The narrator 
proceeds through the basic steps for 
entering names, dates, and places. 
There is no doubt that these tutorials 
are like those blockbuster films such 
as "Gone With the Wind." Everytime 
you view it, you pick up new infor-
mation or see other details you failed 
to see the first time around! The 
same is doubly true with the Legacy 
tutorials. Many of us will need to 
view the tutorial more than once to 
really grasp the protocols used in 
Legacy.  
 
  The one saving grace, however, is 
that by viewing the tutorials or using 
the "help" window, we become more 
aware of what can be done in each 

given situation and where to look to 
get it done. In this regard, we should 
note a few places in Legacy (besides 
"help") where one can find the dif-
ferent choices, variables, and options 
available. They are usually listed 
under "Options" or "Customize" in 
the window where you are working. 
These items can also be seen in the 
"Options" tab in the toolbar. The 
group was dumbfounded at the myr-
iad of "options and choices" avail-
able to meet practically any genea-
logical situation!  
 
  While viewing these tutorials is a 
good way to learn how to do things 
in Legacy, the best teacher, of 
course, is the actual hands-on experi-
ence of entering, manipulating, and 
displaying your family data. The 
hard part is being aware of all the 
techniques and choices you have and 
when and where to use them! Per-
haps these tutorials will eventually 
expose those options and choices. 
 
  As this tutorial proceeded this eve-
ning, we stopped occasionally for 
questions and observations. As the 
hour approached 9 PM (in the inter-
est of those wishing to watch the 
Presidential Debate), we stopped the 
CD in the middle of "Places." We 
shall continue where we left off at 
our next session, 7 PM, Tuesday, 
December 2nd at Dave's house.  
 
 

October 2008 Genealogy SIG Notes 
 

By Dave Howell, Computer Users of Erie 
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This article has been obtained from 
APCUG with the author’s permis-
sion for publication by APCUG 
member groups; all other uses re-
quire the permission of the author 
(see e-mail address above). 
 
I suppose some of you might be 
wondering why I have been writing 
about the Ubuntu Linux operating 
system and Linux software. As I 
noted in last month’s article my lap-
top is now my sole computer. Al-
though it has a Pentium 4 processor 
it only has 512 MB of RAM. Natu-
rally, that means it is incapable of 
running Windows Vista. But it does 
easily run Ubuntu with more than 
enough memory to do multi-tasking 
with no reduction in speed. I also 
know that there are a number of the 
members of the SPCUG that use 
computers that are running Windows 
98 or Windows XP. The point is, 
that it is not necessary to try to up-
grade these computers to run Vista 
or to buy a new computer. Instead 
you have the free alternative of in-
stalling Ubuntu or another version of 
Linux. This article will discuss some 
of the range of free Linux software 
and how easy it is to install it. 
 
The original installation CD of Ub-
untu included the OpenOffice soft-
ware. OpenOffice includes a word 
processor, spreadsheet and presenta-
tion applications. These are fully 
compatible with the components of 
Microsoft Office. I frequently re-
ceive documents prepared in MS 
Word and they open directly into 
OpenOffice Writer. I can edit, com-
ment and save a copy in the OpenOf-
fice format. Then I can return the 
modified document to the originator 
in MS Word format with all the edits 
and comments intact. The same is 
true for spreadsheets. The OpenOf-
fice presentationapplication 
(Impress) reads, writes and modifies 

PowerPoint files as easily as Writer 
works with documents. OpenOffice 
also includes a Drawing application. 
Drawing is an application that I 
haven’t used. 
 
Other included software with Ubuntu 
are Ekiga (internet phone software), 
Pidgeon (internet messenger), Evolu-
tion (e-mail), and a remote desktop 
viewer. Graphics software includes 
the F-Spot photo manager, GIMP 
Image Editor and Xsane scanner 
software. Also, there is a CD burner, 
movie player for DVDs and two mu-
sic players. 
 
I grant you that the included soft-
ware doesn’t always meet all the 
needs for many users. So Ubuntu has 
several ways of installing additional 
software. I mentioned last month 
about installing the drivers for my 
printer, scanner and the wireless mo-
dem. This month I will continue with 
other applications that are the 
equivalent of those that I used under 
Windows. The installation of these 
applications was much easier than 
installing drivers for the accessory 
hardware. 
 
The first step in installing any appli-
cation is to go to the Applications – 
Add/Remove menu. When this ap-
plication runs it provides you with a 
list of all the software available 
through Ubuntu and its third-party 
providers. On the left side of the 
window are listed various categories 
that you can highlight and the appro-
priate applications are then listed on 
the right side. When you highlight a 
specific application, a description 
appears in the lower portion of the 
window. There is also a search box 
that you can use to find a specific 
program or a group of programs. 
 
Since I maintain my financial re-
cords on my computer I wanted a 

financial program that ran under Ub-
untu. Not knowing the specific 
name, I just searched on the term 
"finances". This brought up a list of 
financial software. One of the inter-
esting aspects of the Add/Remove 
application is that programs are rated 
based on feedback from users using 
1 to 5 stars. There was a 5 star appli-
cation listed, GNUcash, which can 
import files in the Quicken format. 
So I put a check mark in the box by 
the application name and then 
clicked on the "Apply Changes" but-
ton. This brought up another window 
for verification of the changes to be 
made. After clicking on "OK", the 
application was downloaded from 
the Internet and installed on the hard 
drive without any further action on 
my part. A shortcut icon was also 
added to the Office portion of the 
applications menu. There was no 
reboot required to complete this 
process. After the installation, the 
"Add/Remove" application reported 
the successful installation and re-
mained open in case I wanted to use 
it further. 
 
My Windows financial software was 
Microsoft Money. Supposedly it will 
export its data files in the Quicken 
format. I did that and then copied the 
files from the Windows partition to 
the Ubuntu partition. However, the 
import into GNUcash was not really 
successful. I’m not sure why but I 
suspect there was information miss-
ing which resulted in misidentifica-
tion of some of the accounts. Any-
way, I selected an arbitrary date and 
entered opening balances for that 
date. So now, it is working perfectly 
and is in agreement with my bank 
balances. Using it is even somewhat 
easier than working with either 
Money or Quicken. Plus, the price is 
right. 
 

(Continued on page 8) 

Ubuntu & Linux Software 
 

By Brian K. Lewis, Ph.D., Sarasota Personal Computer Users Group, Inc., Florida  www.spcug.org  bwsail@yahoo.com 
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Another application that I needed for 
Ubuntu was a genealogy program. 
Here again I was able to find a five 
star program, GRAMPS. (Very ap-
propriate name I thought.) It was 
also available through the "Add/
Remove" application so installation 
was completed quickly. GRAMPS 
imports GED files as do many gene-
alogy programs. So I exported my 
files from my Windows software in 
the GED format then copied the 
GED file to the Ubuntu partition. 
The import into GRAMPS was es-
sentially a two-click operation. Eve-
rything, including notes and refer-
ences, were now available in an Ub-
untu application. GRAMPS also has 
more report formats than my Win-
dows software included. So I con-
sider it a very successful replace-
ment. 
 
For quite some time I have used a 
PDA, specifically a Sony Clie which 
runs Palm Pilot software. The Sony 
CD loaded the Windows version to 
the hard drive and also included soft-
ware to synchronize with the PDA. 
Since I have considerable contact 
information in the Clie along with 
many memoranda, I really wanted to 
be able to run this under Ubuntu. In 
the System-Preferences menu there 
is a selection for PalmOS devices. 
Now that sounded like it would be 
quite simple to install the applica-
tions necessary to run the Clie. 
Clicking on the selection runs the 
Gnome-Pilot application which helps 
the user to determine the settings for 
synchronizing with the Clie. Unfor-
tunately, it could not find the Clie 
PDA. So I had to go back online to 
the Ubuntu forums to see if I could 
find the secret. It turns out that get-
ting a PDA recognized and synced 
with Ubuntu is not always simple. 
After spending considerable time 
reading various solutions I came 
across a command line entry that 
showed the entries where my Clie 
was being recognized by Ubuntu. 
The PDA was properly identified by 
vendor and product ID’s. Now all 

(Continued from page 7) the information I had gathered indi-
cated that the PDA should be listed 
as using a USB connection and usu-
ally ttyUSB0 and ttyUSB1. Much to 
my surprise my printout showed the 
Clie as using ttyUSB9 and 
ttyUSB10. The Gnome-Pilot soft-
ware refused to accept either of these 
as valid locations. However, another 
application, J-Pilot, accepted 
ttyUSB10 and synced with the Clie 
when the sync button was clicked. 
The synchronization transferred all 
of my information directly into the J-
Pilot software. This software works 
on the desktop in a very similar man-
ner to the Clie and Pilot software I 
had used under Windows. Succes-
sive synchronizations have also been 
successful. So that was one less ap-
plication that would need to run un-
der Windows. 
 
There has been one big disappoint-
ment in the hardware setup. I have a 
multi-function media card reader 
built into the laptop. It reads SD 
cards as well as xD, MMC, and 
memory sticks. This reader works 
great under Windows as a way to 
transfer photos from my camera to 
the computer. However, there is ap-
parently no driver available for this 
to work under Ubuntu. The card 
reader is manufactured by 02 Micro 
and they apparently don’t believe 
Linux is here to stay so they have no 
plans to create Linux drivers for any 
of their products. At least that’s the 
quotation from a response to a query 
from a Ubuntu user. So when I have 
photos to transfer to my computer I 
can either reboot into Windows, or I 
can connect the camera with a USB 
cable. The USB cable works fine as 
Ubuntu recognizes the camera right 
away. It also opens the F-Spot Photo 
Manager which allows me to choose 
the pictures and the location where I 
want them saved. 
 
One of the applications included 
with Ubuntu is Brasero, a CD/DVD 
burner. When I first tried to use it, it 
refused to recognize my DVD+R 
discs. It would read and write DVD-

R/RW with no difficulty. Since I had 
a supply of the +R discs I decided to 
look for other DVD burning soft-
ware. In the ADD/Remove applica-
tion there were several CD/DVD 
burners listed. One of them was five 
star application called K3B. It was 
written primarily to work with the 
KDE destop that is an alternative to 
the GNOME desktop. The KDE 
desktop comes with Kubuntu and 
has an interface that is closer to the 
one found in Windows. Anyway, 
K3B will work with GNOME, so let 
ADD/Remove install it. Any soft-
ware that you add through Add/
Remove can be removed simply by 
locating it in the list and removing 
the checkmark that indicates it has 
been installed. So now I have both 
Brasero and K3B installed. I also 
found, the next time I wanted to burn 
a DVD, that Brasero would now 
work with my external burner and 
the +R discs. I do like the interface 
for K3B better than Brasero, but they 
both work. 
 
As you can see one of the nice attrib-
utes of using open license software is 
the ability to install it and use it at no 
cost. If you don’t like it, you simply 
remove it. It’s certainly not that sim-
ple in Windows. So, if you want to 
try a Linux OS on your computer 
download a "Live CD" and try it out. 
Also check out the online help fo-
rums. I think you’ll find them easier 
to understand than much of the mate-
rial Microsoft makes available. 
Whatever you decide, enjoy your 
computing! 
 
Dr. Lewis is a former university and 
medical school professor of physiol-
ogy. He has been working with per-
sonal computers for over thirty 
years, developing software and as-
sembling systems. 
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This meeting could easily have been 
called a "MultiSIG SIG" because the 
discussion covered Internet websites, 
PCs, MACs and Genealogy in depth! 
Check it out.... 
 
Tom demoed various sites available 
through Google - e-mail, word proc-
essing, maps, chrome, HEPA, patent 
searches, blog sites, translators, view 
translate, etc. He showed us his G-
mail account which avoids junk mail 
and spam. Through Google you can 
get the free Norton Security scans. 
 
Olen told us of his problem with his 
Quicken accounts - how to keep his 
business account separate from his 
personal account. Solutions to his 
dilemma were suggested. 
 

We discussed Winbeam, cable 
broadband, DSL and other bundled 
plans for RoadRunner and HDTV. 
 
We viewed the latest Seinfeld-Bill 
Gates ads found on recent TV broad-
casts. Also visited were various sites 
showing paradies about the Apple-
PC rivalry. The discussion mirrored 
what goes on at a Mac SIG session. 
 
Later Carole brought up her prob-
lems trying to work on her family 
history on her MAC laptop which 
she brought to the meeting. She 
showed us her collection of grave-
stone images. She wanted to know 
how to enlarge each image. We went 
to "Findagrave.com" and learned 
what information is available on that 
site and how to add information to it. 
 

  Ed. Note: 
 
  This article was inadvertently omit-
ted from the issue it was received 
for. Although late in publication, it is 
presented here to give you an insight 
into what happens at our BUG SIG 
meetings. 
 
  My apologies to Dave and Tom for 
the delay in publishing this. 
 

August BUG SIG Notes 
 

By Tom Kuklinski and Dave Howell, Computer Users of Erie  

Editor’s Notebook 

  As noted earlier in this issue, CUE 
has a new vendor partner on-board, 
namely Focal Press.  
 
  All CUE members are eligible to 
take advantage of their UG discount 
of 20% off all titles they sell by use 
of the coupon code 92995 when or-
dering. 
 
  They publish a wide range of titles, 
but those most interesting to you will 
probably be the ones dealing with 
digital photography, Photoshop and 
Photoshop Elements, and other im-
aging and graphics programs. They 
also have a variety of video and au-
dio related titles. 
 
  Check out their catalog at 
www.focalpress.com. There is a link 
to them on our website. Click on the 

banner ad on the home page to reach 
their site. NOTE, however, that the 
banner ad takes you to their PAR-
ENT site...the Focal Press link is on 
the left side of that page.  I have an 
inquiry in to our contact to see if the 
banner can be set to take you direct 
to the Focal site, but for now, it 
needs to follow their guidelines. 
 
 
  The Review Software listings page 
is back online (or will be shortly af-
ter you read this). It is slim pickings 
right now, with only two titles up for 
ffer at this point.  
 
  Remember, writing a review of any 
software title offered OR requesting 
a book from one of our vendor part-
ners and reviewing it here, earns you 
that item to keep, FOR FREE!! If 

there is something you would be in-
terested in reviewing, please contact 
me and I will see about obtaining it. 
If it is NOT on the software review 
page, just ask me...many times ven-
dors allow review copies to be ob-
tained, they just don’t advertise it 
heavily, and you need to dig for 
them. 
 
 
  The holidays are fast approaching. 
Due to the dates involved, please get 
me any items for the December and 
January issues as quickly as possible, 
and as close to the deadline dates as 
you can. 
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  Taking Better Photos 
 
  It never fails. Someone gives you a 
picture of yourself from a recent get-
together but the top of your head is 
cut off (or in the case of my grand-
mother, most of my body is cut off!). 
Too often when taking a picture peo-
ple just point and shoot and think 
they’ll make the photo better in a 
photo-editing program. 
 
  Sure, you can change a lot of things 
in a program like Photoshop, but 
why not take advantage of the digital 
camera’s LCD and create a great 
shot when you take it? 
Here are some pointers from a class I 
taught a few years back: 
 
Learning to See 
 
  Decide how you can best capture 
the shot by choosing a suitable view-
point and controlling what appears in 
the final picture. A photograph is 
merely a two-dimensional image of 
what we saw/see. Our eyes work in 
completely different ways; each eye 
offers a slightly different view. The 
two views together gives a strong 
impression of depth and spatial rela-
tionship. 
 
  Example: Focus on something in 
the room, close your left eye, and 
look at the object. Repeat with the 
right eye. Note the different perspec-
tive you get from each eye. 
Successful composition is dependent 
on your ability to look at a scene and 
decide exactly what to point the 

camera at so the images recorded can 
capture the drama and grandeur of 
the broader view. The human eye is 
drawn to specific things. Here are the 
items that will capture the attention 
of your viewer, listed in order of im-
portance: 
 
Movement 
 
  Our eyes naturally go to even the 
slightest movement in a still frame. 
If there are several moving objects, 
our eyes jump among them. A good 
rule is to have just one new thing 
happening at a time to lead the 
viewer’s eye around the frame. 
Color Differences 
 
  One small patch of bright color 
against a dark background draws the 
eye into it. In general, warm colors 
attract the eye more than cool ones. 
Weight of Objects in Frame 
Objects with more size get more at-
tention, but this can be manipulated. 
Big objects in the distance have less 
weight than smaller objects in the 
foreground that take up more screen 
space. 
 
Creating Balance 
 
  Where you position the focal point 
in the frame is important because 
that will determine if the picture ap-
pears visually balanced. Use the rule 
of thirds: divide your camera’s view-
finder using two imaginary horizon-
tal and vertical lines so a grid is 
formed. The focal point may be posi-
tioned at one of the four intersection 

points created by the grid. The rule 
of thirds can be applied to any sub-
ject: portrait, still life, wildlife pho-
tography, architecture, and land-
scape. 
 
  A slight tilt of the camera will shift 
the balance. Move downward to em-
phasize the landscape and fore-
ground; move upward to make a fea-
ture of an interesting sky. The hori-
zon is generally best positioned ei-
ther a third up from the base of the 
image or a third down from the top 
to give a more balanced image. 
Never try to force a picture to com-
ply with the rule of thirds, but more 
often than not you will find that it 
can be applied in some way. 
 
Leading the Eye 
 
  Look for and find lines. Lines can 
be used to divide, to add a strong 
graphic element, or even as the main 
focus of composition. 
 
  Horizontal lines echo the horizon 
and the force of gravity. Vertical 
lines are more active than horizontal. 
They produce dynamic compositions 
with a stronger sense of direction. 
Tip: To maximize the effect, shoot in 
the upright format so the eye has 
farther to travel from the bottom of 
the frame to the top. 
 
  Diagonal lines have great direc-
tional value and add depth by sug-
gesting distance and perspective. 
They can also contrast strongly with 

(Continued on page 11) 

Mac Hints-n-Tips 
 

By Paul Taylor,  Mac Hints and Tips,   www.mac-hints-tips.com   paul@mac-hints-tips.com 

Remember to check the CUE Website at www.cuerie.com 
for a listing of Review Software. 

 
Contact the Editor to request a software title to review; test it, write 

a review for the newsletter, and it’s yours to keep...for FREE!!! 
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Membership News 

Current Membership:     43 
 
 
New Members:      none last month 
 
 
Renewals Received:  Ken Fosco     David Szymanski     Bruce Carter      
Bill Ellis      
 
Renewals Due: Bob Huber     Hadley Jones        Carol Repoff     Art Delano      
Don Grim     Dave Howell     Mark Ellis     Sam Fletcher     Gene Meeks   
Santa Merrifield     Olen Seidler     Lee Skywark     Judy Lyons 
 
 

Remember, a CUE Membership makes a nice present!! 

the previous types of lines to create 
dynamic compositions that catch and 
hold the eye. Converging lines are 
the most powerful. When included in 
a photo, they add a very strong sense 
of depth. 
 
  Example: Railroad tracks. If you 
stand in the middle and look down in 
the distance, the parallel lines appear 
to move closer together until they 
eventually seem to vanish. 
 
Filling the Foreground 
 
  By exploiting the area of a scene 
closest to the camera (the fore-
ground), you can create a strong 
composition. Anything can be used 
as foreground interest: roads, fences, 
rivers, streams, paths, rocks on the 
shore, a flowerbed. Natural features 
tend to make the composition more 
interesting. Shadows can be used as 
foreground interest. 
 
Composing for Impact 
 
  Take a few steps closer. Get in the 
habit of asking yourself if moving 
closer to the subject would improve 
the composition. Photos of people 
will be more intimate. Action shots 
will be full of drama. Landscapes 
will lack empty space. Explore your 
subject from all angles — don’t as-
sume your photos have to be taken at 
eye level. Take photos at an elevated 
position. Bend down/stretch out on 
your stomach. Compose with color, 
which lends strong aesthetic power. 
Example: Bold, contrasting colors 
such as blue and yellow, or red and 
green, will produce a photo that’s 
exciting to look at. 
 
  Use your camera on its side. By 
using the camera in a vertical posi-
tion, you can include much more 
foreground or sky. This makes the 
eye travel farther from the top to bot-
tom, leading to an active composi-
tion. 
 
 

(Continued from page 10) Web Site Resources 
 
  BetterPhoto.com features online 
photography courses, digital camera 
ratings and reviews, great tips for 
improving photographic technique, 
camera comparisons, photo contests, 
Q&A, free email newsletters, and 
expert help with all aspects of begin-
ning photography. 
<www.betterphoto.com> 
 
  Shortcourses.com is a complete 
guide to digital cameras, digital pho-
tography, and digital video. 
<www.shortcourses.com> 
 
  Photojojo.com — A website and 
newsletter dedicated not only to tak-
ing better photos, but doing cool and 
useful things with them. They say 
“We find the most kick-ass photo 
tips, DIY projects, and gear and 
bring them to 
you.”<www.photojojo.com> 

~ Holly Buttura 
Small Dog Electronics 

 
 
 
 
 

Leopard 
 
Cool Leopard Tips 
 

  If you have already installed the 
new Mac operating system, OS 10.5 
(Leopard) you are probably enjoying 
some of the great new features. 
If you haven’t, you might be inter-
ested in some of those features and 
how you make them work. 
 
  Incidentally, if you do have Leop-
ard installed, be sure you keep up 
with the software updates and install 
them as soon as you are aware of 
them. 
 
  Since Leopard is a brand new oper-
ating system Apple will be releasing 
updates as they find any problems 
and you will find that your system 
will run better with each update. 
10.5.1 is already out. 
 
  To check on updates click on the 
Apple menu > Software Update. 
It is hard to pick out the best new 
features, but here are three that I 
really like that I think have universal 
appeal. 
 
  The Mail application has added a 
number of new features. You can 
now add stationery with built-in tem-
plates for invitations, announce-
ments, etc. 
 
  These templates allow you to in-
clude photos. You can also now add 

(Continued on page 12) 
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numbering, bullets, indentations, and 
colored text to your messages. 
Mail Tip One 
 
  Choose a stationery template for 
your email that can be read by both 
Macs and PCs. The add stationery 
button is on the far right of the tool 
bar. When you click the button, your 
stationery choices open for you and 
you just click one to choose it. You 
can even make a choice after you 
have created your text and Mail will 
fit your content into the stationery. 
 
Mail Tip Two 
 
  Add an image to a stationery Tem-
plate in a designated spot. Make sure 
that your image is in a format that 
does well across the Internet (.jpg, 
.pdf, gif, etc.) 
• Drag and drop the image 
into the designated space. 
Or 
• Click Photo Browser in the 
toolbar to view available images in 
your iPhoto files and then drag an 
image from there. 
Or 
• Click the Attach button in 
the toolbar or choose File > Attach 
File, and then select an image from 
wherever it might be on your com-
puter. 
 
Mail Tip Three 
 
  Use numbering, bullets, indenta-
tions, and colored text in your 
emails. While in the process of creat-
ing a new message select the For-
mats Menu. 
• Choose “lists” to get bullets 
or numbers. 
• Choose “Indentations” to 
indent. For colored text choose the 
color icon from the menu bar and 
select the color you wish to use. You 
will be required to check a box mak-
ing your document a “Rich Text” 
document to proceed. 
 
  Another cool new feature include in 
Mail is the ability to create a new 

(Continued from page 11) address card in Address Book from 
information included in the content 
of an email message. (This only 
works if you are receiving your mail 
through the Mail application.) 
• Click on the address in the 
body of the message. A box forms 
around the information with an ar-
row in the bottom right corner. 
• Click on that arrow. You are 
given the option of creating a brand 
new card, adding to an existing card, 
viewing a map for that address, or 
viewing the information in larger 
type. 
• Click on “Create New Con-
tact” and a card will be created con-
taining the information. If there is a 
name included the card includes the 
name. If no name is included, the 
card is created using the name of the 
sender. The card will be opened for 
you so you can change the name if 
necessary. 
• Click on “Add to Existing 
Contact” and the information will be 
added to an existing card. If there is 
a name with the address then you are 
done. If there is not, the information 
will be added to the sender’s card 
and you will be given the opportu-
nity to change the name. 
 
  Note: If you already have an ad-
dress in place for the individual that 
address will remain and the new ad-
dress will be added as a second list-
ing. 
 
  Note: If additional addresses or 
phone numbers are included without 
name identifiers, they might be 
picked up as well. If that happens, 
just delete them from your card be-
fore you save. 
 
  Preview now gives you the ability 
to print several different images on a 
single sheet of paper. They can be 
the same or different images. Print 
several different images on a single 
sheet of paper. Or print multiple cop-
ies of the same image to cut out and 
share with friends. 
• Open your image using Pre-
view 4. (Right-click on the image 

icon, select “Open With,” and then 
select “Preview,” or open Preview 4 
and drag the image across the Dock 
icon). Select View > Sidebar 
• A sidebar will open contain-
ing an icon of your image. Drag ad-
ditional images onto the sidebar. 
You can drag different images, or 
drag images of the same picture if 
you want to print multiples of the 
same photo. Drag as many as you 
want to fit on one page. 
• When you are ready to print 
click on the first icon in the sidebar 
and then Command/click on each of 
the other images. 
• Select File > Print Selected 
Images 
• Mark your settings and click 
Print. 
 
  These tips, and many more are in-
cluded in the revised version of 
Nancy Gravley’s new manual, Tips, 
Hints, and Solutions For Seasoned 
Beginners Using Apple Macintosh 
Computers With Mac OS X 10.4 and 
10.5. 
Entire table of contents and sample 
pages available for review from 
http://www.capmac.org/%
7enancygravley/
bifocalsbooksample.pdf. 
 
  The book is available as a black-
and-white, spiral-bound printed book 
($17.15 plus shipping), as a color pdf 
($9.85, download) or as the color 
PDF on a CD with hyperlinks for the 
various topics covered.  
 

~ Nancy Gravley 
MacObserver via Mouse Tales, 

NorthCoast MUG, Berea, OH 
 
 
 
 

iPhoto Library Rescue 
 
  In the past week I have had to res-
cue or revive three clients’ iPhoto 
Libraries, which leads to the ques-
tion of how this is done. 
 

(Continued on page 13) 
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Want YOUR  
Business card here?? 

_____________ 
 

 Please  mail inquiries concerning advertising rates to 
CUE, PO Box 8941, Erie, PA 16505-0941 Attn: Advertising. 

OR 
  Email cuerie1@verizon.net  

 
Advertise in HORIZONS to increase your sales traffic!! 

  The most common problem in re-
cent versions of iPhoto has been one 
in which the thumbnail images in the 
main catalogue window are replaced 
by grey squares. Sometimes double-
clicking these reveals the full-size 
photo, but sometimes that has also 
been replaced by plain grey. 
 
  In general, no photos have been lost 
— what has been damaged is the 
index information that iPhoto uses to 
keep track of their location. Foresee-
ing that this might occur for a variety 
of reasons, Apple has provided 
iPhoto with an internal library re-
building routine. 
 
  [Note that this kind of problem is 
frequently caused by a user’s attempt-
ing to add to, extract from, or other-
wise manipulate the contents of the 
iPhoto Library folder, normally found 
in your Pictures folder. It is not in-
tended that you ever access the con-
tents of this folder directly, and 
iPhoto ‘08 actually turns it into a 
‘package’ — a single large file that 
severely inhibits tampering. If you 
want to revise the content of the 
iPhoto library in any way, you must 
do it via the main iPhoto catalogue 
window.] 
 
  Before undertaking the rebuild 
process though, make sure that you 
are using the latest update available 
for your version of iPhoto. You can 
check this using Software Update. 
The built-in rebuilding routine is 
accessed by holding down a particu-
lar pair of keys while opening 
iPhoto. In versions 4 and 5 the keys 
are the Option and Shift keys, while 
in version 6 and later they are the 
Command and Option keys. 
 
  Holding down the appropriate pair 
of keys will halt the iPhoto opening 
process before any photos appear, 
and you’ll be asked about the kind of 
rebuild you want to perform. If in 
doubt, simply tick all the boxes and 
proceed, recognizing that the process 

(Continued from page 12) can be a long one if you have thou-
sands of photos. 
 
  Sometimes this rebuild routine 
works, but often it doesn’t. The next 
step is to try the repair function in-
cluded in iPhoto Library Manager 
(free for this function), which is dif-
ferent in that it attempts to build a 
completely new library, resolving 
problems as it goes. Sadly though, it 
will often be tripped up by the same 
problems that cause Apple’s method 
to fail. 
 
  When all else has failed, your only 
option is to extract the photos from 
the damaged library and re-import 
them into a new library. Since an 
iPhoto Library contains all manner 
of folders, thumbnail images and 
support files, it helps greatly if you 
have a utility that can extract just the 
full-size photos and leave the rest 
behind. The one I use is iPhotoEx-
tractor (free) that is effective, though 
rather slow as it’s AppleScript based. 
Be prepared to wait hours if you 
have thousands of photos. 
 
  Also make sure you have enough 
free disk space to accommodate the 
extracted (actually copied) photos. 
When the process is finished, import 
the extracted photos into a new li-
brary — hold down the Option key 
while opening iPhoto in order to cre-
ate one with a name and location of 
your choosing. Again you’ll need 
plenty of free disk space, as iPhoto 
actually copies the photos into its 
library. 
 

  [An alternative method is to search 
the old Library folder, or its subfold-
ers in turn, for all files larger than 
about 72KB, which should filter out 
the dross. This method has the ad-
vantage that you can drag the found 
items directly into a new iPhoto win-
dow, avoiding the intermediate copy 
process.] 
 
  Unfortunately you will have lost all 
your albums, your photo ratings and 
keywords, though iPhotoExtractor 
does give you the option of saving 
titles rather than the original file 
names. At least you will have the 
photos with their EXIF data includ-
ing dates, which will help with your 
reconstruction of the library. 
 

 
AUSOM News, Melbourne, Australia 

 
 

 
Ed. Note: 
 
  For more of these hints and tips, be 
sure to visit the website at  
Www.mac-hints-tips.com . 
 
  This is by no means the complete 
listing of tips received each 
month...space restrictions and con-
tent balancing makes use of all of 
them impossible...they would make a 
full newsletter by themselves. 
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Horizons Classifieds 
 
    FOR SALE:  
 
ADVERTISE YOUR ITEMS HERE!!! 
 
   
Remember, CUE members may advertise any item they wish to sell or buy 

in this space, free of charge. Please be sure to get any listings to the 
Editor by the monthly issue deadline. 

 
  Please note that all transactions are between private individuals, 
and CUE is not responsible for any issues that may arise. CUE is 
just providing the ad space. 

CUE Marketplace 

For the latest CUE news visit our website at  
www.cuerie.com 

 
OR 

 
Join the CUE email list. To do so, send an email to 

cuelist@szy.com, and use  
SUBSCRIBE as the subject. 

 
 
 
 
 
 
 

Remember, all CUE members receive a  
 

30% Discount 
 

on  all book purchases.  
 

You may order online at www.peachpit.com 
 

Use the coupon code UE-23AA-PEUF at check-
out (note it is CASE SENSITIVE). 

 
 
 
 
 
 
 
Need to subscribe or renew an existing subscription? 

 
Visit www.smartcomputing.com, and give CUE 
credit fro your new or renewal subscription.  

 
Use the User Group link on the left menu, and fol-
low the links from there to the subscription page. 
By doing so, CUE receives credit towards free sub-

scriptions to use as door prizes or raffles. 
 

Tell all your friends!! 

Want an ad here, to get the word out about your 
company or its services? 

 
Contact the editor as cuerie1@verizon.net and ask 

for a copy of the latest advertising rates. 
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Please Print 
 
Application Type: □ New      □  Renewal      □  Info Change  Today’s Date: ___________________ 
. 
Name: _______________________________________________________________________ 
 
Address:  _____________________________________________________________________ 
 
City:  ____________________________     State:  __________     ZIP+4:  __________________      
 
Home Phone:  ___________________     Alt. Phone: ____________________     Fax:  ___________________ 
 
Email address:  ________________________________     Referring member:  _____________________ 
 
It is CUE’s policy to keep your information confidential.However, for contact regarding SIGs, meetings and a possible Help Directory, 
may we release the following to other members: 
 

Home Phone:  □  Yes     □  No and/or Email Address:  □  Yes     □No 
 
Please indicate how you wish to receive your monthly newsletter issue. Please note that if you choose US Mail delivery, there will 
be a $10 surcharge added to your dues to help offset the rising postage costs to mail your newsletter. 
 

□  E-Mail        □  US Mail        □  Pickup at meeting 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
How did you hear about CUE?  ________________________________________________________________ 

Computer Users of Erie Membership Application 

X Computer Interest Low Med High 

 Office Applications    

 Digital Imaging    

 Graphics    

 Internet    

 Operating Systems    

 Macintosh    

 Programming    

X Computer Interest Low Med High 

 Advanced Technology    

 Hardware    

 Networking    

 Financial    

 Genealogy    

 Beginner’s Group    

 Other:     

Skill Level Skill Level 

X Volunteer Interests 

 Greet Guests and Members 

 Newsletter Reporter 

 Software / Book Review 

 Photographer 

 CUE Demonstrations 

X Volunteer Interests 

 SIG Leader 

 Present Programs 

 Publicity Activities 

 Solicit Advertising 

 HELPLINE Resource 

Dues Rates 
 

      Regular membership:    $20.00 / year  
Newsletter by US Mail:  $30.00 / year 
Student membership:    $15.00 / year 

 
Student members MUST present proof of student status 

Mail completed application and check to: 
 

Computer Users of Erie 
Membership 
PO Box 8941 

Erie, PA  16505-0941 

X Computer Platform(s) 

 Windows 9x/ME 

 Windows 2000 / XP 

 Macintosh 

 Linux 

 Other: 



Directions to 
Holy Rosary School 

CUE Members and Visitors 
 

Arriving at the school, turn into the drive between the Church and the School building. 
Proceed through the chain poles at the rear of the drive into the main parking lot. 

Turn RIGHT in the lot, and proceed to the far end of the parking lot. 
Park anywhere near the ramp and steps. Enter through that doorway, the meeting room is to your LEFT. 

 
**If the chain is up at the rear of the drive, go around the corner and into the lot from 27th Street** 

Postmaster: Address Service 
Requested 

Horizons 

Computer Users of Erie 
PO Box 8941 
Erie, PA  16505-0941 

Address label here 

Postage 
here 

Finding Holy Rosary 
 

From the West 
  Take 26th St. (Rt. 20) to the intersection 
of Parade Street. Turn right, go to the next 
light. Make a hard left turn onto 28th St. 
Follow to the school, which will be on your 
left. 
 
From the South 
  From Rt. 19 (Peach St.), Rt. 97 or Rt. 8, 
follow that street to 38th Street. Head east 
on 38th street. Turn LEFT onto East Ave. 
from East 38th street (first traffic light east 
of the intersection of Rt 8 (Pine Ave.) and 
East 38th St. The school will be immedi-
ately in front of you when you reach the T-
intersection of East Ave. and 28th St. 
 
From the East 
  Follow Rt. 20 WEST to Broad Street. Fol-
low Broad street until you see Wal-Mart and 
McDonalds on your left. Turn LEFT onto 
Burton Ave.  When you reach the end of the 
street, turn RIGHT onto 28th St. School will 
be on your right in approximately 3 blocks. 


